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Notices
References in this publication to IBM products, programs, or services
do not imply that IBM intends to make these available in all countries in
which IBM operates. Any reference to an IBM product, program, or
service is not intended to state or imply that only IBM’s product,
program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any of IBM’s intellectual
property rights may be used instead of the IBM product, program, or
service. Evaluation and verification of operation in conjunction with
other products, except those expressly designated by IBM, are the
user’s responsibility.
IBM may have patents or pending patent applications covering subject
matter in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in
writing, to the IBM Director of Licensing, IBM Corporation, 500
Columbus Avenue, Thornwood, NY 10594.

Trademarks
The following terms are trademarks or registered trademarks of the
IBM Corporation in the United States or other countries or both:
• Aptiva
• IBM
• Mwave
• OS/2
Other company, product, and service names may be trademarks or
service marks of others.
Microsoft, Windows, and the Windows 95 logo are trademarks or
registered trademarks of Microsoft Corporation.
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Purpose
These instructions are intended to help you remove your combination
sound and modem card. It must be replaced with a new modem card
and a new sound card to retain the audio and modem functions of the
combination sound and modem card. If your computer does not have a
combination sound and modem card, these instructions do not apply to
your computer.

System Recovery
In some cases, you may need to use the Recovery CD-ROM that
comes with your computer. If you need to reload the hard disk drive
with the original software configuration and you have not created the
Emergency Recovery Disk, you will need to re-install the combination
sound and modem card before you begin the process. Re-installing the
combination sound and modem card before the recovery process will
reduce the number of errors your computer will have while restoring
the software.

Using the Emergency Recovery Utility
After you have installed the new sound and modem card drivers, you
should create an Emergency Recovery Diskette by using the
Emergency Recovery Utility to save critical configuration and system
files. See “Emergency Recovery Utility” on page 16. These files are
necessary if you ever recover your system using the Recovery CD. In
this event, you will need to boot your system with the Emergency
Recovery disk in the floppy drive. This prevents you from having to
install and uninstall the Mwave card.
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Unsupported functions and applications
After you remove the combination sound and modem card and its
drivers, certain factory installed functions or applications designed
specially for your combination sound and modem card will no longer
operate. The following tables identify those applications or functions.
If you cannot locate the model number of your computer, see “To find
the model number:” on page 2.
For the latest up-to-date information about your Aptiva computer, go to
the World Wide Web at:
http://www.pc.ibm.com/support/

Note: The address is case sensitive. Type it exactly as shown here.

Unsupported functions and applications
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Unsupported applications in your Axx model
personal computer
Unsupported
Applications
Aptiva FAX Center
Aptiva Operator
Audio Station
Country Select
IBM Internet Connection
Rapid Resume
Scheduler
Suspend from Windows
95 Start menu
Quicken Special Edition
Financial Network
Video CD Player
Wake Up on Ring
Silent Steel
To the Moon - Flight of
the Dream Team
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Unsupported functions and applications

Frequently Asked Questions
For the latest FAQ information, go to the World Wide Web at:
http://www.pc.ibm.com/support/
Then, follow these steps:
1 Click on "support search" on the left of the page.
2 Type in pmys-3tcrth in the search field to search for the FAQ
document.
Note: The address is case sensitive. Type it exactly as shown here.

Warranty and Technical Support
Warranty. Please refer to the documentation included with your new
modem and/or sound card for warranty and technical support
information.

Conventions used in this book
Mouse Clicking
Follow the mouse clicking instructions exactly as they are written in
this book.

When you see...

it means...

Click

Click once with the left mouse button.

Double-click

Rapidly click twice with the left mouse button.

Right-click

Click once with the right mouse button.

Frequently Asked Questions
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Highlighting
There are several ways that text is highlighted in this book. Each
highlighting convention has a specific purpose.

Highlight

x

Purpose

Bold

Bold font is used to identify items on the screen
which you should click or double-click. Bold font is
also used in headings, table titles, and numbered
lists.

Example

Example font is used to show text that you need to
type from your keyboard.

Italic

Italic font is used to show proper names of
programs or books. Italic font is also used in table
footnotes and sidenotes.

“Quotes”

Quotation marks are used to identify window,
screen, and heading names.

Underline

Underline font is used to call special emphasis to a
particular word or instruction.

Conventions used in this book

Getting Started
A word before you begin...
Make sure you have the following items:
• Technical Update CD package, IBM part number 10H2856
• A flat head screwdriver (not included)
• A pen or pencil

This document will guide you through the complete process of:
1 Preparing to remove the Mwave drivers and the card

Note
To ensure proper setup, follow the
instructions in the order they are
written.

2 Removing the Mwave drivers and the card
3 Changing software settings.
To ensure proper setup, follow the instructions in the order they are
written.

Getting Started
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Preparing to remove the Mwave drivers and card
Before you remove the drivers and card, you must identify the model
number of your computer.

To find the model number:
Locate the sticker that shows the model number of your computer.
• On a desktop or minitower system unit, you can find the sticker behind
the drop down door on the front of the system unit.
• On a split system (with a minitower and media console), you can find
the sticker beneath the handle on the minitower.
When you find the model number, write it here for easy reference:

The rest of the instructions in this book will refer to generic model
numbers. For example, if your model number is 2168-A50, the
instructions that apply are marked “...model Axx computer”.
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Preparing to remove the Mwave drivers and card

Removing the Mwave drivers
To remove the drivers, follow these instructions:
1 While the computer is turned on, close all open programs.
2 Place the Technical Update CD into the CD-ROM drive.
NOTE: If the “Technical Update CD program” starts automatically
(usually within a minute), click Close. Go to step 3.
If you see an error message that says, “This Service CD does not
support your Aptiva model...”, click OK. This message does not apply to
this procedure.
3 From the Windows 95 “Start” button, click Run...
4 When the “Run” dialogue box appears, click Browse.
5 Double-click My Computer.
6 Double-click the CD-ROM drive.
7 Double-click the Updates subdirectory.
8 Double-click the Mwavedr subdirectory.
9 Double-click Setup.
10 From the “Run” dialogue box, click OK.
11 The “Modem & Audio Installation” dialogue box asking if you want to
continue will appear. Click Yes.

Note
You should make a backup copy of
any personal files you have placed
in the “Mwave_c”, “Mwd”, and
“Mww” directories.

12 Another “Modem & Audio Installation” dialogue box will appear.
If you have any personal files in the “Mwave_c”, “Mwd”, and “Mww”
directories (or their subdirectories), you should click No, backup your
personal files, and restart these steps.
If you have no personal files in the directories, click Yes.
13 The Windows 95 Operator Agent “Information” dialogue box will
appear. Read the message and click OK.
14 The “Information” dialogue box telling you that “Install needs to restart
Windows...” will appear. Click OK.

Removing the Mwave drivers
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Wait while the computer restarts. It may take several minutes before
the next “Information” dialogue box appears.
15 The “Information” dialogue box saying that the software has been
removed will appear.
Remove the CD-ROM from the CD-ROM drive.
Read the message and click OK.
16 The “Modem & Audio Installation” dialogue box asking if you are going
to remove the Mwave adapter card will appear. Click Yes.
NOTE: Do not press Enter. You must click on the Yes button.
17 The Windows 95 shutdown “Information” dialogue box will appear.
Click OK.
18 Use the Windows 95 Start button to shutdown the computer.
19 Follow the instructions in “Removing the Mwave card” on page 5.
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Removing the Mwave drivers

Removing the Mwave card
Danger!
Electrical current from power,
Before you make any changes to hardware in your computer, you must
telephone, and communications
turn off and unplug the computer.
cables is hazardous. To avoid shock
hazard, use the steps described in this
section to disconnect the cables when To disconnect the system unit:
installing, moving, or opening the
1 Shut down all programs and turn off the computer.
cover of this product.
2 Turn off any attached component that has its own power switch.
To avoid shock hazard, do not
connect or disconnect any cables or
perform installation of this product
during an electrical storm.

3 Unplug all power cables from electrical outlets.
4 Remove all signal cables (such as the telephone cable) from their
receptacles.
5 Disconnect all cables attached to the computer; this includes power
cords, input/output cables, and any other cables attached to the
computer.

If you have a desktop system unit:
1 Follow the instructions in “To disconnect the system unit:” above.
2 Remove the system unit cover. The cover on the desktop system
slides along grooves that run along the sides of the frame. Follow
these steps:
a Press on the corner of the system unit door to open it.

Removing the Mwave card

5

b Press up on the cover release latch and slide the cover off
completely.

3 Touch the bare metal frame of your system unit to dissipate the static
electricity from your body. Do not touch any of the components inside
the frame before you touch the frame. Do not touch any component
with a voltage warning label.

If you have a minitower system unit:
1 Follow the instructions “To disconnect the system unit:” on page 5.
2 Remove the system unit cover. The cover on the minitower system
slides along grooves that run along the sides of the frame. Follow
these steps:
a Remove the screws.
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Removing the Mwave card

b Slide the cover forward and completely remove it from the system
unit.

3 Touch the bare metal frame of your system unit to dissipate the static
electricity from your body. Do not touch any of the components inside
the frame before you touch the frame. Do not touch any component
with a voltage warning label.

To remove the Mwave card:
When you have completed the steps to disconnect the computer and
remove the cover, you can remove the Mwave card. Follow these
steps:
1 Locate the Mwave card, which looks like this:

Removing the Mwave card
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2 Carefully disconnect the two cables that may be connected to the card.
Use caution when you remove the audio cable. This cable typically has
a green connector. Pull up on the connector - do not pull directly on the
cable.
3 Remove the other end of the audio cable that is attached to the
CD-ROM drive. On some minitower systems you may have to remove
the four screws holding the CD-ROM drive and slide it out far enough
to access the audio cable connector on the rear of the drive.
Do not attempt to disconnect the other end of the cable with the black
connector. It is connected to the system board.
4 Remove the adapter card screw and set it aside. You will need it when
you install a replacement sound card.
5 Carefully pull the adapter card straight out of the slot.
If you have a minitower system unit, turn it on its side so the system
board faces you. To ensure that the system unit lays flat, make sure the
base (bottom) of the system unit hangs over the edge of your work
surface.

6 Store the combination sound and modem card in a safe place, away
from sources of static electricity that may damage sensitive
components on the card. You may need the card in the future if you
want to restore the original factory installed software. For more
information, see “System Recovery” on page vi.
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Notes for installing replacement sound and modem cards
If you have a desktop system unit, make sure you
have followed the instructions “To disconnect the
system unit:” on page 5 and “If you have a
desktop system unit:” on page 5.

Note
Please see the instructions that
come with sound and modem
replacement cards

If you have a minitower system unit, make sure
you have followed the instructions “To disconnect
the system unit:” on page 5 and “If you have a
minitower system unit:” on page 6.

Notes for installing a replacement sound card:
• Locate an empty ISA card slot.

Note
If you have a desktop system unit,
make sure the audio cable runs
beneath the bracket that holds the
diskette drive.

• Touch the static-protective package that contains your sound card to
any unpainted metal surface in the computer.
• Remove the sound card from the package.
• Locate the open adapter card slot from which you removed the Mwave
card.
• Align and insert the card into the adapter card connector and insert the
screw.
• Locate the audio cable included with your sound card.
• Remove the old audio cable.
• For information on connecting the speaker, headset, and microphone
to the modem and sound cards, refer to the documentation that comes
with your sound card.

Note
If your computer came with the
wake up on ring feature, it will not
be available with this modem.

Notes for installing a replacement modem:
• Locate an empty ISA adapter card slot. Remove the screw and set it
aside for use later. Remove the adapter card slot cover.

Notes for installing replacement sound and modem cards
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• Touch the static-protective package containing the modem card to any
unpainted surface in the computer.
• Remove the modem card from the package.
• Align and insert the modem card into the adapter card connector and
insert the screw.
• Replace the system unit cover and reconnect the cables.
Note: After installing your new sound and modem cards, you should
perform the Emergency Recovery Utility" as shown on page 16 to save
(backup) critical configuration and system files. These files are
necessary if you ever recover your system using the Recovery CD.

10

Notes for installing replacement sound and modem cards

Changing software settings
The following information is provided to assist you in reconfiguring your
system for non-Windows 95 programs and running MPEG programs
originally included with your system. These steps do not have to be
performed at this time for you to begin using your new sound card and
modem cards. They will need to be performed before some
non-Windows 95 programs and original MPEG functions will operate
correctly.

To change the modem COM port setting:
During the Windows 95 installation process, the system will
automatically set the modem COM port. If a program you use requires
the modem to be set to a specific com port, you may need to change
the setting.
To change the com port setting, refer to your modem’s documentation.

To change software to run MPEG programs originally included
with your computer:
Most of the MPEG software that came with your computer will run
without additional setup. However, in some cases you may need to
update other software settings for the MPEG software to run properly.
To make these updates, find the instructions in this section that apply
to the model you purchased and follow them.

Important: Before changing software to run MPEG programs, be
sure you save your critical configuration and system files. See
“Emergency Recovery Utility” on page 16.
1 While the computer is turned on, close all open programs.
2 Place the Technical Update CD into the CD-ROM drive.
If autoplay is enabled, the “IBM Aptiva Technical Update CD” window
will appear. Click Close and continue at step 3b.
If autoplay is not enabled or if you see the error message “This service
CD does not support your Aptiva model...”, follow these instructions:
a Click OK.

Changing software settings
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b Double-click the My Computer icon on the Windows 95 desktop.
c Highlight the “Techupcd” icon by clicking it once.
d Right-click Techupcd. A menu will appear. Click Explore.
e From the “Exploring - Techupcd...” window, double-click the Ie30
directory.
3 Double-click Msie30~1.
4 The “Microsoft Internet Explorer Setup” window will appear. Read the
agreement and click Yes.
Internet Explorer setup will begin to extract files.
5 The “Microsoft Internet Explorer Setup” dialogue box will appear
asking if you would like to select the optional Internet components to
install. Click Yes.
6 Make sure “ActiveMovie” is selected. You can select other options if
you wish. However, the only option required for this update is
ActiveMovie. Click OK.
The computer will begin to copy files.
7 The “Microsoft Internet Explorer Setup” dialogue box will appear
asking if you want to restart the computer. Click Yes.
The computer will automatically restart.
8 Once the computer has restarted, close the open windows.
9 From the Windows 95 Start button, click Run.
10 When the “Run” dialogue box appears, press the Delete key to remove
the contents of the “Open” box.
11 Type:
sysedit
and then click OK.
The “System Configuration Editor” window will appear.
12 From the “Window” menu, click C:\WINDOWS\WIN.INI
13 From the “Search” menu, click Find.
14 In the “Find” box, type [mci extensions] (including the brackets)
then click Next.
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The “[mci extensions]” line will be highlighted. Press the down arrow
key until you can see the entire [mci extensions] section.
a When you see “mpg=reelmagic”, replace it with: mpg=MPEGVideo.
b When you see “dat=reelmagic”, replace it with: dat=MPEGVideo.
15 From the “Search” menu, click Find.
16 In the “Find” box, type [ibmmpg32] (including the brackets) then click
Next.
The “[ibmmpg32]” line will be highlighted. Press the down arrow key
until you can see the entire [ibmmpg32] section.
Type a semicolon “;” as the first character on each line. The section
should look like this:
;[ibmmpg32]
;ProportionalScale=1
;Zoomby2=0
;GDI=No
17 From the “File” menu, click Save.
18 From the “Window” menu, click C:\WINDOWS\SYSTEM.INI
19 From the “Search” menu, click Find.
20 In the “Find” box, type [mci] (including the brackets), then click Next.
The “[mci]” line will be highlighted. Press the down arrow key until you
can see the line “reelmagic=ibmmpg16.dll”.
Type a semicolon ; as the first character on the line. The line should
look like this:
;reelmagic=ibmmpg16.dll
21 From the “File” menu, click Save.
22 Close the “System Configuration Editor” window.
23 From the Windows 95 Start button, click Run.
24 When the “Run” dialogue box appears, press the Delete key to remove
the contents of the “Open” box.

Changing software settings
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25 Type:
regedit
and then click OK.
The “Registry Editor” window will appear.
26 From the “Edit” menu, click Find...
The “Find” window will appear.
27 In the “Find what:” box, type:
ibm16sel.dll
and then click Find Next.
28 If the search finds ibm16sel.dll, make sure the
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\control\
SessionManager\Known16DLLs] directory is the current directory.
Continue at step 31.
29 If the search does not find ibm16sel.dll, make
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\control\
SessionManager\Known16DLLs] the current directory.
30 Press and hold the Ctrl key while you click any of the following files that
appear in the directory:
ibm16sel.dll
ibmcdi16.dll
ibmcdi32.exe
ibmmpg16.dll
ibmmpg32.exe
31 When all the files are highlighted, press the Delete key.
32 When the “Confirm Value Delete” dialogue box appears asking if you
are sure you want to delete the values, click Yes.
33 From the “Registry” menu, click Exit.
34 Use the Windows 95 Start button to restart the computer.
35 A Caution dialogue box appears with the following text:
Some of the file types usually associated with ActiveMovie are currently
associated with other programs. Because of this, you may be unable to
play certain types of multimedia files. Do you want to fix this (by
restoring the file types to ActiveMovie?
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Click Yes.

Changing software settings
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Emergency Recovery Utility
Using ERU
To create a bootable system diskette:
1 Open a DOS window by clicking on the Start button. From the “Start
Menu”, select Programs, then MS-DOS Prompt.
2 Insert an empty diskette into your floppy drive and at the DOS prompt
type:
format a: /S
Windows will format the disk then copy the files required to make the
disk bootable. Pre-formatted diskettes must be prepared in this manner
in order to be used as a bootable system diskette.
To create the Emergency Recovery Disk:
1 Insert the Microsoft Windows Companion CD in your CD-ROM drive.
Execute d:\OTHER\MISC\ERU\ERU.EXE, where d is the drive letter of your
CD-ROM drive.
The “Emergency Recovery Utility” window appears. Read the
information in this window and click Next.
2 You have the choice of saving your critical configuration and system
files to either a floppy disk or a folder on your hard drive. The
“Emergency Recovery Utility” window allows you to select “Drive A”
or “Other Directory”. Choose the option to save to Drive A (floppy disk)
by clicking in the circle next to Drive A, then click Next.
3 A window appears with instructions for inserting the bootable system
diskette that you created into drive A. Follow these instructions and
click OK.
4 You will see a dialogue box with a list of all the important configuration
files that ERU saves by default. We recommend you use the default
settings. Click Next.
5 A bar graph will show the ERU progress as it saves the files you
selected. When finished you see a dialogue box indicating that the
Emergency Recovery creation completed successfully. Click OK.
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6 Remove the diskette and store it in a convenient place. You will need to
use this diskette to restore your saved files if you should ever recover
your system using the Recovery CD. Simply reboot your computer with
the diskette in the floppy drive after recovering your system. ERUs
restore utility, Emergency Recovery Disk (ERD), will start automatically
and guide you through the restoration process.

Saving to a hard drive
To make a complete ERU backup on your hard drive:
1 Follow the instructions above until ERU asks you to select a drive. Click
on the circle next to Other Directory and then click Next. ERU will
suggest C:\ERD. Type the drive letter of choice and click Next again.
2 Click Next to save all the critical configuration and system files.
Remember, you will need to restore your saved files if you should
recover your system using the Recovery CD.

Emergency Recovery Utility
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